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1 Introduction 

In this installation manual, you will receive step-by-step instructions on how to install eCase, 

version 11.0.0. If you are a Windows System Administrator, this manual was primarily written 

with you in mind. However, if you instead hold one of the IT positions listed below, or perform 

duties related to one or more of those IT positions, then this manual is also intended for you. 

• Database Administrator 

• Development Manager 

• IT Technical Writer 

• IT Project Manager 

• Software Engineer 

• Software Tester 

 

A major goal of the eCase Installation Manual — in addition to guiding you through a successful 

installation — is to provide supplemental information in appendices about eCase that you will 

find useful and time saving. 

This document does not cover the System Requirements, we strongly recommend that you 

review System Requirements document before installation to understand about eCase 

deployment architecture and server requirements. The system requirements for the required 

servers referred in this document are explained in System Requirements document. 

1.1 Scope 

The information presented in this manual covers how to install eCase Version 11.0.0, onto the 

Application Server in a Windows Server, Network Operating System (NOS) environment. Given 

that certain components are essential in completing the installation, topics covered include the 

following: 

• Configuring the database server for use with eCase 

• Configuring the file repository server for use with eCase 

 

This manual does not provide instructions about installing Windows Server NOS. For installation 

details, please consult the appropriate Windows Server installation documentation, or your 

software vendor. 
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1.2 Overview 

eCase is a robust, web application that helps organizations to create case management 

applications through low code approach. In other words, eCase helps organizations to automate 

their business processes by automating the entire lifecycle of a workflow, a process referred to 

as a case. 

1.3 References 

The following resources are used as references in preparing this manual: 

• eCase System Requirements Manual 

• eCase Prerequisites Installation Manual 

1.4 Installation Prerequisites 

Ensure the following software applications are installed on the server on which you plan to install 

eCase: 

• .NET Framework version 4.8 

• IIS version 8.5 or later 

 

Also, ensure that the SMTP server is configured, so that emails can be relayed to intranet and 

internet domains. 

(!!) Note: 

Although you can install eCase web application, eCase Admin application, the database, file 

repository and the scheduler service on the same server, distributing them on separate 

servers is highly recommended due to their processing demands on the CPU. This installation 

approach helps eCase and its essential components to achieve higher levels of performance. 

Please refer to System Requirements document to understand about eCase deployment 

Architecture. 

 

(!!) Notes: 

For information about how to determine which .NET Framework is installed on your server, 

direct your web browser to the following URL: 

https://msdn.microsoft.com/en-us/library/hh925568(v=vs.110).aspx 

https://msdn.microsoft.com/en-us/library/hh925568(v%3Dvs.110).aspx
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For information about downloading and installing .NET Frameworks, direct your web 

browser to the following URL: 

https://msdn.microsoft.com/en-us/library/5a4x27ek(v=vs.110).aspx 

 

https://msdn.microsoft.com/en-us/library/5a4x27ek(v%3Dvs.110).aspx
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2 Step 1: Creating the Database 

This chapter guides you step-by-step through the process of creating a database for use with 

eCase. Before you install eCase, carry out the steps in this chapter.  

2.1 SQL Server Database 

The type of database you will create in this section for use with eCase is a SQL Server Database. 

Follow the step-by- step procedures outlined below to create the database. 

To create the SQL Server Database 

1. Double-click the eCase folder, and then double click the Server folder. 

2. Right-click the Setup.exe file, and then click Run as administrator on the short-cut menu. 

 

3. The Setup will show the Help Window with list of manuals. Click on any link to view the 
corresponding manual. In left panel, click Configuration to setup the database. 
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4. On the task panel of the eCase Configuration window, click Create eCase Database, and 
then click SQL Server on the short-cut menu. 

 

5. In the eCase Database Server dialog box, type the license key in the License Key box (if 
this box is empty), and then click Continue 
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(!!) Note: The license key is in a file included with the set up CD. If this file is in the same 

folder as the Setup.exe file, the license key will be entered into the License Key box 

automatically. 

 

6. In the eCase Database Setup dialog box, do the following: 

a. Type the server name in the Server Name box 

b. Under Authentication Mode, ensure SQL Server Mode (default) is checked. 

c. Type your SQL Server login ID in the Login ID box, and then type password in the 
Password box. 

d. The SQL Server Login ID is required to have permissions either to create new 
database for eCase or get the list of databases to select a blank database for eCase. 

7. Click Next. 
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8. If you are creating a new database, do the following: 

9. Select “Database Name” option and enter the database name 

10. Enter the SQL Server Login ID/Password created and assigned as database owner for 
new database. 

11. Check the Configure Repository check box. 

12. Click Next. 
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13. If you are using an existing blank database, do the following 

a. Select “Select Database” option and select a blank database created by your DBA 

14. Click Next to configure Repository 

15. Please select Repository Type: Native or SharePoint. 
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16. Select Document Search Service option for Native Repository. 

a. If Windows Search Service selected, you have to install Windows Search Service 
on eCase Application server and Repository root directory location should be 
configured on eCase Application Server in local drive (For example, D:\DMS). 

b. If eCase Search Service selected, Repository root directory location can be local or 
a network location (For example, remote file repository location on 
Server_Name01 will be configured as, \\Server_Name01\DMS) 

17. Enter the File Storage Area Name, Root Directory (local drive or network location as 
described above) and Capacity in MB. If Root Directory is: 

a. Local Path: Install eCase Scheduler on eCase Application Server when eCase 
Search Service selected. 

b. UNC Path: Install eCase Scheduler either on eCase Application Server or on a 
different server. Configure the service with a domain user account and set the 
Read, List Folder Contents, Read & Execute permissions to Repository location. 
To configure eCase Scheduler Service user account refer the eCase Scheduler 
Configuration topic. 

18. Click Next to Configure eCase Authentication and System Account details. 

file://///Server_Name01/DMS
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Field Name Description 

eCase Login Mode Forms – Standard level of access for the eCase application; 

this is the default option 

Single Sign On – Allows the user to automatically log into 

eCase without prompting for credentials 

eAuthentication – An authentication service provided by a 

proxy/remote server to other distributed servers, on the 

internet or an intranet; users must submit requests to obtain 

login/logout credentials. 
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Field Name Description 

Membership Provider Database – Login credentials will be stored in the eCase 

database; this is the default option 

LdapMembershipProvider – Login credentials will be stored 

and verified by the LDAP server; this option must coincide 

with the Portal application 

Login The unique identifier that verifies the Admin user’s identity; 

this system administrator user manages the eCase 

application. 

Password The security credential associated with the Admin user to 

gain access to the application. 

Confirm Password Same as above 

First Name The first name of the Admin user 

Last Name Surname of the Admin user 

Email Email address for the Admin user 

Time Zone The region that has a uniform standard time; the current 

time zone is selected by default. 

LDAP Server Name The name of the LDAP server 

Service User Name The identifier given to a user that has access to the LDAP 

server entered as Server name/User Name 

Service User Password The security credential associated with the Service User 
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Field Name Description 

Domain The name of the IP resource to access the database server. 

eAuthentication ID An electronic authentication identifier for the Admin user; 

the user must submit a request to obtain an ID. 

eAuthentication Log Out 

URL 

A URL that logs out an authenticated user from the server 

with the specified callback method and user state; the user 

must submit a request to obtain the web address 

 

19. In the Organization and fiscal year configuration details dialog box, fill out the boxes 
with the requested information, and then click Next. 
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20. When you receive the “Ready to Setup the eCase database” message, click Finish. 

 

21. When you receive the “Database Successfully created” message, click OK. 
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3 Step 2: Installing eCase 

eCase is installed on the Microsoft Internet Information Services (IIS) web server. 

3.1 Install eCase 

1. Go to eCase folder, and then open the Server folder. 

2. Right-click the Setup.exe file, and then click Run as administrator on the short-cut menu. 

 

3. On the navigation panel of the eCase Help window, click Installation. 

 

 

4. On the task panel of the eCase Installation window, click Install eCase Application. 
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5. In the eCase Application Server dialog box, type the license key in the License Key box (if 
this box is empty), and then click Continue. 

 

(!!) Note: The license key is in a file included with the set up CD. If this file is in the same 

folder as the Setup.exe file, the license key will be entered into the License Key box 

automatically. 

 

6. The Set up new eCase application option selected by default. 

7. Read the Welcome to the eCase Installation Wizard dialog box, and then click Next. 
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8. Read the Software License Agreement dialog box, then click I accept the license 
agreement (default), and then click Next. 

 

 

(!!) Notes: 

• The Next button remains disabled until the option to accept the license agreement is 

selected. 
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• The Reset button sets the default to I do not Accept the License Agreement. 

 

9. In the User Information dialog box, do the following: 

a. In the Full Name box, type your first name and last (sir) name. 

b. Optional: In the Organization box, type the name of the organization that you 
work for. 

c. In the Product Serial Number box, type the eCase application serial number (if this 
box is empty). 

 

d. Ensure Everybody who uses this computer is checked, and then click Next. 

 

10. In the Destination Folder dialog box, click Next to accept the default folder in which to 
install eCase, or click Browse to choose a folder of your choice. 
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11. In the Select Features dialog box, click Next to install all features of eCase. 

eCase OData Services and eCase SOAP Services are not required unless integrations 

with external systems are required. eCase Application, eCase Admin and eCase 

Scheduler Service are required to be installed. They can be deployed on same server or 

on different servers in production environments to meet the performance requirements. 

 

12. In the Ready to Install the Application dialog box, click Next. 

 

13. When the Updating System dialog box appears, let the installation process run to 
completion. (This process could run for several minutes.) 
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(!!) Note: It is highly recommended that you let the installation process run uninterrupted. 

For information about uninstalling eCase, see Appendix D. 

 

14. When the eCase Database Configuration dialog box appears, click Close. 

15. The eCase Database Configuration dialog box appears if you selected at least one feature 
shown in step 10 of this chapter during the installation process. You can skip filling out the 
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eCase Database Configuration dialog box at this time. You can configure the database in 
the next section. When you receive the “eCase has been successfully installed.” message, 
click Finish. 

 

 

3.2 Verifying the eCase Installation 

After installing eCase, you must next verify the installation. This chapter guides you through the 

verification process. 

To verify the eCase installation: 

1. On the task bar, click Start > All Programs > Administrative Tools > Internet Information 

Services (IIS) Manager. 

2. In the Connections panel, Expand the Start Page > Sites > and Default Web Site. 

3. Expand the eCase folder. 

4. Locate Manage Applications > Browse Application on the right side of the screen. 

5. Click Browse *:80 (http). 

6. In the eCase Login dialog box, type your User Name and Password, and then click Sign In. 
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7. Click Help > About eCase. 

 

8. Make sure the version is correct then close the screen. 

9. Exit the application. You have successfully installed and configured eCase. 

(!!) Note: If you are unable to launch eCase, try to re-create the database and repository 

again. 

 



 

 27 

4 Step 3 (Optional): Installing eCase Add-on 

Modules 

eCase add-on modules are not required unless they are required to meet your business 

requirements. You can skip this optional step when not required. 

4.1 Install eCase PDF Editor 

To install eCase PDF Editor, please make sure eCase application is installed, then follow the 

steps below. 

1. Open Server folder. 

2. Run the Setup.exe as run as Administrator. 

 

3. Click the Install eCase PDF Editor under Installation section.  
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4. eCase PDF Editor Welcome screen will appear. Click Next. 

 

5. In End-User License Agreement, please accept license details and click Next. 



Step 3 (Optional): Installing eCase Add-On Modules 

 29 

 

6. In Destination Folder screen, click Next. 

 

7. Click Next. 
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8. Installation is in progress. 

 

9. Click Finish. 
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4.2 Install eCase OCR Components 

eCase OCR Components should be installed on the same server where eCase scheduler is 

installed. To install eCase OCR Components, follow the steps below on the eCase Scheduler 

server. 

1. Open Server folder. 

2. Run the Setup.exe as run as Administrator. 

 

3. Click on Installation and click on Install eCase OCR Components 
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4. The message below appears, click Yes to continue. 

 

 

5. eCase OCR Components Welcome screen appears. Click Next. 
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6. In User Information screen, please provide the details and click Next. 

 

 

7. In Destination Folder screen, click Next. 
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8. Click Install  

 

 

9. Installation is in progress. 

 

10. Click Finish. 

11. After successful installation of eCase OCR Components, please Configure the OCR in 
eCase Scheduler using eCase Database Configuration. 
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12. Open eCase Database configuration and select eCase Scheduler Service in 
Application/Service drop down box and then Save the database configuration. 

 

13. After saving the database details, eCase Scheduler Configuration screen will appear. 
Select eCase Optical 

14. Character Recognition Service check-box and Save the Configuration and Close. 
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15. Click Save and close. 

 

 

4.3 Install Document Review Management 

To install eCase Document Review Management, please make sure eCase application and the 

scheduler is installed. 

To install eCase Document Review Management: 

1. Open Server folder. 

2. Run the Setup.exe as run as Administrator. 
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3. Go to Installation and click on Install eCase Document Review Management. 

 

4. Click Next to continue. 
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5. Please accept to agreement. Click Next. 

 

 

6. In User Information screen, please provide the details and click Next. 
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7. In Destination Folder screen, click Next. 

 

 

8. Click Next. 
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9. After successful installation, click Finish.  

 

10. Next, please configure the Document Review Management in eCase Scheduler using 
eCase Database Configuration. 

11. Open eCase Database configuration and select eCase Scheduler Service in 
Application/Service drop down box and then Save the database configuration. 
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12. After saving the database details, eCase Scheduler Configuration screen will appear. 
Select Document Review Management checkbox and Save the Configuration and Close. 

 

13. Click Save and close. 
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4.3.1 Enable Find and Redact Feature 

To install eCase, follow the steps below. 

(!!) Note: Before executing scripts below, please make sure that the OCR is installed and 

configured.  

1. Copy the FOIAXpress.Utilities.UDFRegExp.dll into SQL Server machine and place the 
dll into C:\temp. 

2. Then, login to SQL Server Management Studio as “SA” and execute the following 
queries. 
 
EXEC sp_configure 'show advanced options' , '1'; 

GO 

reconfigure; 

GO 

EXEC sp_configure 'clr enabled' , '1' 

GO 

reconfigure; 

GO 

 

3. Lastly, register the FOIAXpress.Utilities.UDFRegExp.dll assembly within SQL Server 
using SQL Server Management Studio by executing the following queries. 

 
GO 

CREATE ASSEMBLY RegExP 

FROM 'Provide file path'  

GO 

CREATE FUNCTION dbo.REGEXP_LIKE(@Input nvarchar(max),@Pattern nvarchar(500)) 

RETURNS nvarchar(max) 
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AS  

EXTERNAL NAME RegExP.UserDefinedFunctions.REGEXP_LIKE 

GO 
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5 Privileges for eCase Application Server 

and Services 

The following section lists all applicable directories and their required permissions for the 

application to communicate with the file repository and load the assemblies. The privileges 

outlined in the following sections are relevant to eCase web application and web pages. 

5.1 Required Permissions for ASP .NET Process 

Identify 

The security permissions outlined below are specifically for the ASP.NET Process Identity (IIS 

Application Pool Identity). In 8.5, the Application Pool Identity by default is set as the NETWORK 

SERVICE user and as the Application Pool Identity user in IIS 8.5 or above. 

If eCase configured with Single Sign-On Authentication, both the IIS Application Pool Identity 

users and all the 

eCase users must have the permissions on files and folders listed in the table below. 

If eCase configured with Forms Authentication, only the IIS Application Pool Identity user must 

have the permissions on the files and folders listed in the table below:. 

ASP .NET Process Identify Permissions 

Location Access type Comments 

%SystemRoot%\Microsoft.NET 

\Framework\versionNumber\ 

Temporary ASP.NET Files 

Read, List 

Folder 

Contents, 

Read & 

Execute, Write 

This is the location for dynamically 

compiled files. Beneath this location, 

application code generation takes 

place in a discrete directory for each 

application. 



Privileges for eCase Application Server and Services 

 

 45 

Location Access type Comments 

%SystemRoot%\System32 Read, List 

Folder 

Contents, 

Read & 

Execute 

This contains system DLLs loaded by 

the .NET Framework. 

Program Files\AINS 

eCase\eCase 

-OR- 

Program Files\AINS 

eCase\eCase 

Read, List 

Folder 

Contents, 

Read & 

Execute 

This is the location for application 

files. 

%SystemRoot%\Microsoft.NET 

\Framework\version and 

subdirectories 

Read, List 

Folder 

Contents, 

Read & 

Execute 

ASP.NET must be able to access the 

system assemblies referenced in the 

Machine.config file in the CONFIG 

subdirectory under 

%SystemRoot%\Microsoft.NET\Fr 

amework\version\. 

Temporary Path Modify, Read 

& Execute, 

ListFolder 

Contents, 

Read, Write  

All eCase temporary files are stored 

in this location. 
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Location Access type Comments 

Program Files\AINS 

eCase\eCase\App_Data 

-OR- 

Program Files\AINS 

eCase\eCase\App_Data 

Modify, Read & 

Execute, List 

Folder 

Contents, 

Read, Write 

This location stores dictionary files 

for Spell Check. 

Program Files\AINS 

eCase\eCase\Images 

-OR- 

Program Files\AINS 

eCase\eCase\Images 

Modify, Read & 

Execute, List 

Folder 

Contents, 

Read, Write 

The enterprise logo and eCase 

application images will be stored in 

this location. 

Program Files\AINS 

eCase\Reports 

Modify, Read & 

Execute, List 

Folder 

Contents, 

Read, Write 

This is the location where temporary 

application report files are stored 

when processed in the application  

For Client Workstations:   

User profile directory Modify, Read & 

Execute, List 

Folder 

Contents, 

Read, Write 

eCase controls will store the 

temporary files before processing to 

the application. 
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5.2 eCase Scheduler Configuration 

If the eCase Database installed with SQL Windows Authentication mode, the eCase Scheduler 

Service user should be the owner of the database. Make sure to install the eCase Scheduler 

Service before you start it. The following procedure details how to configure your eCase 

Scheduler Service to confirm the identity of users before granting access to operate it. 

(!!) Note: The eCase Scheduler Service user must be a member of the local or domain 

Administrator group. 

 

5.2.1 Start the eCase Scheduler Service 

1. Click Start > All Programs > Administrative Tools > Services. The SERVICES screen 
opens with the EXTENDED tab in view. 

 

 

2. Locate and select eCase Scheduler Service. 

3. Right click eCase Scheduler Service and select Properties. The eCase Scheduler Service 
Properties window opens with the General tab in view. 
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4. Click the Log On tab then This Account. The password fields become enabled. 
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5. Enter the user name and password for this account then confirm the password. 

6. Click OK. 

7. If service is currently running, the following message appears. Click OK. 

8. Restart the eCase Scheduler Service. 

9. Select Action Restart from the menu or right-click the on service name and select Restart 
from the short menu. The Service Control window appears detailing the progress to 
restart the service. The Status column should indicate ‘Started’ once completed. 

10. Select File > Exit to close the Services screen. 

 

5.2.2 Required Security Permissions for eCase Scheduler Service 

User 

Location Access 

type 

Comments 

%SystemRoot%\ System32 Read, List 

Folder 

Contents, 

Read & 

Execute 

This location contains system DLLs 

loaded by the .NET Framework. 

%SystemRoot%\ Temp Full 

Control 

This location used for Web services 

support. 

User profile directory Read, List 

Folder 

Contents, 

Read & 

Execute, 

Write 

This location stores the cache files of 

the Report Scheduler Service. 
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Location Access 

type 

Comments 

%SystemRoot%\ 

Microsoft.NET\Framework\versio n 

and subdirectories 

Read, List 

Folder 

Contents, 

Read & 

Execute 

ASP.NET must be able to access the 

system assemblies referenced in the 

Machine.config file in the CONFIG 

subdirectory under 

%SystemRoot%\Microsoft.NET\Fra 

mework\version\. 

Program Files\ECase\Logs 

-OR- 

Program Files\AINS 

eCase\Logs 

Modify, 

Read & 

Execute, 

Read, 

Write 

The application error log and 

configuration files will be stored in 

this folder. 

Program Files\AINS 

eCase\eCase\bin 

-OR- 

Program Files\AINS 

eCase\eCase\bin 

Full 

Control 

The application error log will be 

stored in this file. 
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6 Configure XAML on User Workstations 

Configure Internet Explorer for eCase as follows: 

1. Start Internet Explorer, click Tools, and then click Internet options. 

2. Click the Security tab, and then click Custom level. The Security Settings window opens. 

 

 

(!!) Note: To work with Scan Control with 64-bit Internet Explorer, make sure Enable 

Protected Mode (requires restarting Internet Explorer) is unchecked. 

3. In the XAML browser applications section, select Enable, and then click OK. 



Configure XAML on User Workstation 
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4. Grant read and execute permissions to IIS app pool user on Controls folder if not exist. 
(App Server) 

5. Add the site to the trusted sites. 

6. Set custom level to the red highlighted option. 
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Appendix A: Sign-On Mode Configuration 

After setting up the application server, you can change the Sign-On Mode that you originally 

chose using the eCase Database Configuration utility. The following sections provide 

instructions on how to change to different Sign-On Modes. 

Configure the Application and Access the Sign -On 

Mode Tab 

1. Click Start > All Programs > eCase, right-click eCase Database Configuration and select 
Run As Administrator. The eCase Database Configuration window appears. Select the 
database type, enter the required information, then click SAVE. 

 

eCase Database Configuration 

(SQL Server) 

eCase Database Configuration 

(Oracle) 

 

(!!) Note: The Login Name and Password fields are disabled if Windows Authentication is 

selected for the SQL Server database type. 
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2. Once you save the required information for either SQL SERVER or ORACLE, the 
following message appears. 

 

3. Click Yes to save the information. A confirmation message appears. 

 

4. Click OK. The Sign-On Mode tab displays. 



Appendix A: Sign-On Mode Configuration 

 55 

Change the Sign-On Mode 

Select the Sign-On Mode tab. The following window appears. It shows the Sign-On Mode 

options selected during the database configuration. 

(!!) Note: The different Sign-On Modes vary on how users will connect to eCase and can 

range from the default username/password connection to a more secure windows domain 

authenticated connection. 

 

1. Click the Sign-On Mode drop-down list and select the desired option. Enter the required 
outlined in Error! 
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Field Name Description 

Sign On Mode Forms - Standard level of access for the eCase application. 

Single Sign On - Allows the user to automatically log into eCase 

without being prompted for login credentials. 

eAuthentication - An authentication service provided by one 

remote server to other distributed servers, on the Internet or 

an intranet; users must submit requests to obtain login/logout 

credentials. 

Membership Provider Database - Login credentials will be verified and stored in the 

eCase database; 

this is the default option. 

LdapMembership Provider - Login credentials will be verified 

and stored on the domain where LDAP server is located. 

LDAP Server Name The name of the LDAP server. 

Service User Name The identifier given to a user that has access to the LDAP 

server; entered as 

Server name\User Name. 

Service User Password The security credential associated with the Service User. 
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Field Name Description 

Two Factor 

Authentication 

Check the Two Factor Authentication check box, which 

requires users to submit the client certificates along with login 

and password. It shows when Sign On Mode is forms 

authentication. 

When checked, configure IIS to use SSL for eCase web 

application and select 

“Require” option for client certificate settings. Additional 

configuration steps required are explained in section – “PIV 

Certificates as Two Factor Authentication” 

Client Cert Subject Fields Specify the keys (For example: CN, OU, O) in client certificate 

subject for two-factor validation. These key values are 

compared with Authentication ID field for the user. 

 

2. Click Save. A message window appears. 

 

3. Click Yes to change the Sign-On Mode. A confirmation message appears. 

 

4. Click OK to close the message. 
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5. Click CLOSE to exit the eCase DATABASE CONFIGURATION window. 
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PIV Certificates as Two Factor Authentication 

Please follow the instructions in this document to configure eCase Two Faction Authentication 

with PIV Card. Some organizations may require to have a different server for all PIV challenges 

that is different from application server then it is required to setup second IIS server. In second 

IIS server, do NOT install eCase application. In this document, PIV Server (Second Server) is 

optional, it is required only when your organization policy requires to have a dedicated server. 

You should ignore PIV Server (Second Server) sections in this document when you are 

configuring with Single Server option. 

In this document Steps 1, 2 and 3 are same for Single Server and Two Servers configurations. 

Step 4.a is for single server configuration, Steps 4.b, 5 and 6 are for Two Server configuration. 

System Requirements for PIV Server (Second Server - Optional) 

• Windows 2016 Server with IIS 8.5 server 
• Install URL Rewrite and ARR IIS Modules. You can download these extensions from 

Microsoft web sites. Try these links: https://www.iis.net/downloads/microsoft/url-
rewrite, https://www.microsoft.com/en-us/download/details.aspx?id=47333 

 

Please contact support@opexustech.com if you need any more information or if you face any 

problems with hotfix installation.  

Step 1: Take Database backup 

1. Access eCase database server. 

2. Open Microsoft SQL Server Management Studio. 

3. Right-click on eCase database and take backup. 

4. Once completed, proceed to Step 2. 

Step 2: Install the latest Service Pack (if not applied) 

1. Access the application server where eCase is installed Administrator. 

2. Copy the “eCase v10.1 Service Pack”. 

3. In the main root of the folder, run Hotfix.exe as Administrator as shown below. 

4. Provide the Backup location to take the backup of the Files. 

5. Click Apply. 

6. Confirm that eCase database is backed up. 

7. Installation wizard runs. 

8. Once Hotfix is installed successfully, click OK. 

https://www.iis.net/downloads/microsoft/url-rewrite
https://www.iis.net/downloads/microsoft/url-rewrite
https://www.microsoft.com/en-us/download/details.aspx?id=47333
mailto:support@opexustech.com
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9. Proceed to Step 3.  

Step 3: Install PIV Card Authentication Hotfix 

1. Access the application server where eCase is installed as Administrator. 

2. Please add the following entries to the web.config file located in eCase installed 
directory: C:\Program Files\ECase\eCase 

 

 <location path="Banner/Disclaimer.aspx"> 

 <system.web> 

 <authorization> 

 <allow users="?" /> 

 </authorization> 

 </system.web> 

 </location> 

 <location path="NoPIV.aspx"> 

 <system.web> 

 <authorization> 

 <allow users="?" /> 

 </authorization> 

 </system.web> 

 </location> 

3. Thereafter, run eCase Database Configuration Tool as Administrator. 

4. Select eCase for under Application/Service.  

5. Click Save. 

6. Go to Sign-On Mode tab. 

7. Check the Two-Factor Authentication and provide subject given from the SSL 
Certificate.  

8. Click Save.  

 

Step 4.a: Install SSL Certificate and Configure IIS (Single Server 

Option) 

1. Install Server Certificate into IIS and configure bindings for HTTPS on eCase Application 
Server.  
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2. Open the IIS, and configure the following settings: 

 

3. Click on SSL option above. 

 

4. Reset IIS. 

 

Step 4.b: Install SSL Certificate and Configure IIS (Two Servers 

Option) 

1. Install Server Certificate into IIS and configure bindings for HTTPS on eCase Application 
Server.  

2. Open the IIS, and configure the following settings: 

 

3. Click on SSL option above. 
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4. Reset IIS. 

 

Step 5: Install SSL Certificate and Configure IIS (Two Servers 

Option) 

1. Install Server Certificate into IIS and configure bindings for HTTPS on PIV Server.  

2. Open the IIS, and create a new web site with name URLRewrite with HTTPS binding 
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3. Configure the SSL Settings and URL Rewrite rules as follows: 

 

 



Appendix A: Sign-On Mode Configuration 

 

 64 

4. Set the SSL Settings and Apply: 

 

5. Add a Rewrite rule with Request Blocking template to abort application related traffic, 
except Images and Disclaimer.aspx. Configure the URL blocking rules as shown below. 
Please make sure type, patterns and  
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6. Add a Rewrite rule with Reverse Proxy template to rewrite the traffic to application 
server. Click on Add Rule and enter the application server name to forward request:  
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(!!) Note that Request Blocking rule should be before Reverse Proxy rule. These rules will 

ensure only PIV requests are sent to dedicate PIV server and all application requests are sent 

to eCase Application server. Second server configuration provides the ability to monitor PIV 

server traffic and ignore the application traffic. 

 

7. Add a Rewrite rule with outbound blank rule template to rewrite the rewrite the 
response redirect to eCase app server login.aspx. Click on Add Rule and enter the name 
of the rule as ‘redirectoutbound’.  

a. Select <Create New Precondition…> from the Precondition drop-down. 

b. Click Add in the dialog that appears 
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c. Enter {RESPONSE_STATUS} in the Condition input field and 3[0-9][0-9] in the 
pattern field. Click OK. 

d. Select Server Variable from the Matching scope drop-down. 

e. Enter RESPONSE_Location as the Variable name. 

f. In the Pattern field enter regex: (.*)//(.*)/(.*)/(Login.*) 

g. In the Action Value box enter the URL: https://<eCaseAppServer>/eCase/{R:4} 

h. Click Apply 

i. Outbound rule should look like as shown below 
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All three rules should be in the order as shown below: 
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Step 7: Set the Banner Page location (Two Servers Option) 

Run the following sql query in eCase database with proper PIV Server name to set the banner 

page location: 

Update EC_CONFIGURATION 

SET CONFIG_VALUE='https://<pivservername>/eCase/Banner/Disclaimer.aspx' 

where CONFIG_KEY='BannerPage' 
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Appendix B: Application Maintenance 

This section provides instructions for using the APPLICATION MAINTENANCE REPAIR 

feature. Application maintenance should be performed on the application server and/or the 

server where eCase components are installed. 

The Repair feature automatically detects missing or corrupt files and copies the missing files or 

copies the original damaged files into the registry and/or installation destination. 

(!!) Note: Preferences stored in the registry may be reset to the default values.  

1. Right-click the SETUP.EXE file and select RUN AS ADMINISTRATOR. 

2. Click Installation  Install eCase Application. The eCase APPLICATION SERVER window 
appears. 

3. Make sure the SET UP NEW eCase 10.6 APPLICATION option is enabled. Locate the 
License Key file included with the setup CD if the license key is not already populated 
then click CONTINUE. 

4. The APPLICATION MAINTENANCE window appears with the MODIFY option selected. 
Select REPAIR then click 

5. NEXT. 

 

6. The READY TO REPAIR THE APPLICATION window appears. Click Repair to continue. 
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7. The UPDATING SYSTEM window appears and begins the process of repairing and 
installing components. 

 

 

8. The following window appears after the update has completed. Click FINISH to exit the 
SETUP WIZARD. 
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Appendix C: Cleanup Utility 

Cleanup 

The CLEANUP utility allows users to remove folders, case and application types, choice lists, and 

documents from the eCase application. To access the utility, follow the steps below: 

1. Click Start > All Programs > ECase. 

2. Right-click on eCase CONFIGURATION and select RUN AS ADMINISTRATOR . The 

eCase CONFIGURATION window appears. 

3. Click the CLEANUP tab. 

 

(!!) Note: Cleanup is applicable only when a new Repository is configured. 
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Folder Cleanup 

This option will remove folders and data from the eCase application. Because FOLDER 

CLEANUP is the first option it is also the default option. 

1. Click NEXT. 

2. Select one of the options outlined in Table 0-1 then click NEXT. 

 

(!!) Note: This tool will not copy the folders and its related document data. 

Field Name Description 

Folder ID The unique identifier for a folder. 

Received Between The beginning and ending dates a task/case was received. 

Closed Between The beginning and ending dates a task/case was closed. 

Case Types The type(s) of requests or documents related to cases/tasks. 

Application Types The type(s) of requests or documents related specifically to the 

application. 
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4. Click CLEANUP to remove the folder and data contained in the folder. 
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5. Click Yes on the verification message to proceed with the cleanup. 

 

6. The CLEANUP tab changes to display messaging regarding the cleanup process. 

7. The following message appears once the cleanup process has ended. Click OK to close the 

message. 

Case Type Cleanup 

This option removes Case Types from the eCase application. 

3. Select the CASE TYPE CLEANUP option then click NEXT. 

 

4. Select from the available list then click NEXT. 
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5. Click CLEANUP to clear the selected case types from the application. 

 

6. Click Yes on the verification message to proceed with the cleanup. 

7. The CLEANUP tab changes to display messaging regarding the cleanup process. 
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8. Click OK to close the message. 

Application Type Cleanup 

This option removes Application Types from the eCase application. 

1. Select the APPLICATION TYPE CLEANUP option then click NEXT. 

 

2. Select from the available list then click NEXT. 
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3. Click CLEANUP to delete the selected Application Type. 

 

4. Click Yes on the verification message to proceed with the cleanup process. 
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5. The CLEANUP tab changes to display messaging regarding the cleanup process 

6. A confirmation message appears once the cleanup process has ended. Click OK to close 
the message. 

 

Choice List Cleanup 

This option removes Choice List(s) from the eCase application. 

1. Select the CHOICE LIST CLEANUP option and click NEXT. 

 

2. Make a selection from the available list then click NEXT. Use the <Shift> or <Ctrl> keys 
to make multiple selections. 
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3. Click CLEANUP to delete the selected choice list.  

 

4. Click Yes on the verification message to continue with the cleanup process. 

5. The CLEANUP tab changes to display messaging regarding the cleanup process 

6. The following message appears once the cleanup process has ended. Click OK to close 
the message. 
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Documents Cleanup 

This option removes Documents from the eCase application. 

1. Select the DOCUMENTS CLEANUP option. The list box is enabled. 

 

2. Select for the type of document to remove then click NEXT. 

 

3. Click CLEANUP to delete the selected document. 
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4. Click Yes on the verification message to proceed with the cleanup process. 

5. The CLEANUP tab changes to display messaging regarding the cleanup process 

6. The following message appears once the cleanup process has ended. Click OK to close 
the message. 

 

Export Folders 

The EXPORT FOLDERS feature provides the user with the capability to transfer folders and 

attachments into the eCase 

system based on search criteria. Large quantify of folders can be exported by batch into the 

system by compressing the folders and its contents into a ZIP file.  

1. Click Start > All Programs > eCase. 

2. Right-click on eCase CONFIGURATION and select RUN AS ADMINISTRATOR. The 
eCase CONFIGURATION window appears. 

3. Click the EXPORT FOLDERS tab. 

4. Select search criteria from the drop-down list and enter the name of the ZIP file in the 
available field. 
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5. Click BROWSE. The BROWSE FOR FOLDER window appears. Select the location to 
store the ZIP file then click OK. 

 

 

6. Click Export to continue. A verification message appears indicating the amount of 
folders to be exported. 
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7. Click Yes to begin exporting folders to the designated destination. The eCase 
CONFIGURATION window changes to display the progress of the export. 

 

8. A confirmation message appears once the export is completed. 

 

 

9. Click OK to close the message and return to the EXPORT FOLDERS tab. 

10. Click Close to exit the eCase CONFIGURATION utility. 
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Appendix D: eCase Uninstallation 

This section provides instructions on uninstalling the eCase Application from the application 

server. 

Uninstalling the eCase Application 

The eCase application can be uninstalled manually or by using the eCase SETUP WIZARD. If 

you attempt to uninstall the application using the setup wizard, it will automatically detect the 

previous installation and redirect you to uninstall the application. The uninstall process occurs 

on the application server. 

(!!) Note: To manually uninstall the application click Start > All Programs > Control Panel > 

Programs and Features. Select eCase then click UNINSTALL. The application will be removed 

from the server. 

 

1. Double-click the eCase > Server folders. 

2. Right-click on the SETUP.EXE file and select RUN AS ADMINISTRATOR. 

3. Click Installation > Install eCase Application. The eCase APPLICATION SERVER window 
opens with the SET UP NEW eCase 10.6 APPLICATION option selected. 

 

 

4. Locate the LICENSE KEY file included with the setup CD if the license key is not already 
populated then click CONTINUE. 

 

(!!) Notes: 



Appendix D: eCase Uninstallation 

 87 

To avoid manual selection of the license key make sure the license key file is in the same 

folder as the SETUP.EXE file. 

If a previous version of eCase already exists a verification message will appear. Click Yes to 

uninstall the previous version of the application or click NO to exit the uninstall process.  

The WINDOWS INSTALLER window appears briefly. After several seconds the eCase SETUP 

window appears with MODIFY selected as the default. 

 

5. Select REMOVE and click NEXT. The eCase UNINSTALL window appears. 

 

6. Review the information on the window then click NEXT. The UPDATING SYSTEM 
window appears. 

7. Click FINISH to close the eCase SETUP window once the application is uninstalled. 
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(!!) Notes: 

The SETUP WIZARD may detect services that are actively running on the server. When this 

occurs a message window will appear indicating so. Select the appropriate action to close the 

message window to resume the uninstallation process. 

It is highly recommended not to interrupt the Updating System process. If you must, click 

CANCEL 

The eCase SETUP window will appear. Review the information before proceeding then click 

EXIT 

SETUP to stop the uninstall process or RESUME to continue with the uninstallation. 

Exiting the uninstall process while the system is updating will not remove the entire 

application. You must restart the uninstall sequence of steps to completely remove the 

application from the server. 
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Appendix E: Un-installation Steps for eCase 

Add-on Modules 

Uninstall eCase OCR Components 

To uninstall eCase OCR Components, follow the steps below. 

1. Open Server folder. 

2. Run the Setup.exe as Run as administrator. 

 

3. Click on Installation and click on Install eCase OCR Components. 
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4. Click Yes to continue. 

 

 

 

5. Application Maintenance screen will prompt. Select Remove and click Next. 
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6. Click Next. 

 

7. Uninstallation is in progress please wait. 
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8. Click Finish. 
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Uninstall eCase PDF Editor 

To uninstall eCase PDF Editor, follow the steps below. 

1. Open Server folder. 

2. Run the Setup.exe as Run as administrator. 

 

 

3. Click on lnstallation and click on Install eCase PDF Editor. 
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4. Application Maintenance screen will prompt. Select Remove and click Next. 
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5. Click Next. 

 

 

6. Uninstallation is in progress please wait. 
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7. Click Finish. 
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Appendix F: Troubleshooting 

Syntax error while accessing the Folder Tabs 

Problem: 

Why is a Syntax error being observed while accessing the Folder Tabs? 

Solution: 

Reset Internet Explorer settings to their default condition. 

To reset INTERNET EXPLORER settings follow these steps: 

1. Exit all programs, including INTERNET EXPLORER (if it is running) 

2. Click START, type inetcpl.cpl and press ENTER. The INTERNET OPTIONS dialog box 
appears 

3. Click the ADVANCED tab. 

4. Under RESET INTERNET EXPLORER settings, click RESET. Then click RESET again. 

5. When Internet Explorer finishes resetting the settings, click CLOSE in the RESET 
INTERNET EXPLORER SETTINGS dialog box. 

6. Start INTERNET EXPLORER again. 

 

Failed to decrypt using provider 

'RsaProtectedConfigurationProvider' 

Problem: 

Failed to decrypt using provider 'RsaProtectedConfigurationProvider'. Error message from the 

provider: The RSA 

key container could not be opened. 

Solution: 

Execute a command to provide the AppPool account of eCase. 

1. Open Command prompt 

2. Go to C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727 

3. Execute aspnet_regiis -pa "NetFrameworkConfigurationKey" "Network Service" by 

providing the 
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4. AppPool account of eCase. 

 

* Network Service is the AppPool account of eCase if the AppPool account is WINDOWS Domain 

User account, you have to provide like DOMAIN\UserName. 

In case the issue persists even after following the above-mentioned procedure, provide the Read, 

Read & Execute, and List Folder Contents permissions for the Network Service User to inherit 

the permissions from the parent to all its child objects on the following Path. 

C:\ProgramData\Microsoft\Crypto\RSA\MachineKeys 

Default NTFS Permissions and User Rights for IIS 

For default NTFS File System Permissions and User Rights for IIS, please refer to the link 

https://support.microsoft.com/en-us/help/981949/description-of-default-permissions-and-

user-rights-for-iis-7.0-and-later 

 

Unable to install application by someone other than 

Initial Installer 

Problem: 

A user wants to perform a fresh installation of the application and removes the previous 

installation using the 

Control Panel, Programs and Features Uninstall function. Once the application is removed a 

warning message appears when attempting to re-install the application: “ eCase application 

version (x.x.x.x) has been initially installed by a different user. Please log out and re-login with 

the aforementioned user account to continue with the installation of version x.x.x.x.” (‘x’ 

represents the version number) 

Solution: 

Manually remove the following keys from the registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Installer\UserDat

a\S-1-5-21- 

1522637160-2486600271-3587380157-

4220\Products\3079D6522DDCB1541B9F9E2910894CB7 

https://support.microsoft.com/en-us/help/981949/description-of-default-permissions-and-user-rights-for-iis-7.0-and-later
https://support.microsoft.com/en-us/help/981949/description-of-default-permissions-and-user-rights-for-iis-7.0-and-later
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HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\

Uninstall\{256D9703- CDD2-451B-B1F9-E9920198C47B} 

 

Error uploading large attachments 

Problem: 

Error while uploading large files as attachments into eCase 

Error: System.Net.WebException: The remote server returned an error: (404) Not Found. 

Solution: 

Follow the steps below to resolve the issue. 

1. Open IIS Manager by selecting Start > All Programs > Administrative Tools > Internet 

Information 

2. Services (IIS) Manager. 

3. Expand the Server node > Sites > Default Web Site and select eCase. 

4. In FEATURE VIEW, double-click REQUEST FILTERING. 

5. In the ACTIONS pane, click EDIT FEATURE SETTINGS…. 

6. In EDIT REQUEST FILTERING SETTING window, change the value of Maximum 

allowedcontent length (Bytes).By default, 30 MB is the size. You can increase to your 

desired value. Example: Change the value to 

7. 52428800, then application will support up to 50 MB. 
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(!!) Note: Please restart IIS after you make the required changes. 


